
 
VDOT Trns·port PES User’s Manual December 1, 2011 8-1 

8.  MANAGING CATEGORY ITEMS 
 
Project items are maintained at the category level in Trns·port.  Items are added or changed on 
the Worksheet tab of the Projects tabbed folder window.  The worksheet contains all of the 
project item information in a grid.  Items cannot be created until the category has been created. 
 

8.1  Customizing the Worksheet 
 
The worksheet consists of many columns which can be viewed only by scrolling to the right.  It 
is helpful to know techniques to customize this screen to your preference. 
 

 
 

8.1.1  Changing the Width of Columns in the Worksheet 
 
The width of the columns can be adjusted.  Place your mouse on the narrow vertical strip which 
separates two columns.  The pointer will become a double-headed arrow.  Drag the column left 
or right to make it wider or narrower. 
 

8.1.2   Changing the Order of Columns in the Worksheet 
 
Columns may be moved into a different order placement.  Click on a column heading and hold 
down with the mouse.  An I-bar will appear, running from top to bottom of the entire column. 
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Still holding down, drag the column to the desired location and release.  See 8.1.3 for the 
Suggested Order for Columns in the Worksheet. 
 

8.1.3   Suggested Order for Columns in the Worksheet 
 
The following  listing is the suggested order for arrangement of the columns of the Worksheet.  
You will need to arrange the columns only once.  Thereafter, each time Trns·port is launched, the 
columns will retain this ordering. 
 

 1.  Category Number 
 2.  Project Item Seq. No. 
 3.  Prop. Line No. 
 4.  Item Number 
 5.  Description 
 6.  Lump Sum Units 
 7.  Units 

   8. Estimate Quantity 
  9. Estimated Unit Price 
 10. Extended Amount 
 11. NS Desc & Spec Book # Req’d 
 12. Description (Non-std) 
 13. Spec Book # (Non-std) 
  14. Margin Code 

 15. Non-Bid Item 
 16. Source of Price 
 17. Estimated Price Lock 
 18. Revised Price 
 19. Combine With Like Items 
 

 

8.1.4   Split Horizontal Scrolling in the Worksheet 
 
You can divide a grid into two regions that scroll independently of each other.  This feature, 
known as “split horizontal scrolling”, allows you to leave one or more columns fixed in one half 
of the grid, while being able to scroll through the rest of the columns in the other half of the grid.   
It works much like Freeze Panes in Microsoft Excel.   
 
To use this feature, position the mouse pointer over the small vertical black bar at the left end of 
the horizontal scroll bar. 
 
 

 

Position mouse 
pointer here 
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The mouse pointer changes to a double-headed arrow.  Press and hold the left mouse button and 
drag the mouse to the right to create a new horizontal scrolling border.  When you release the 
mouse button, you will have two independently scrolling regions in the grid. 
 

 
 
 
 

8.2   Adding a Category Item 
 
To add items to the category, first locate the project in the Project List.        
 
Right-click on the project and select Tabbed Folder Change.  Trns·port displays the tabbed 
folder.   
 
Click on the Worksheet tab.  If no items exist yet for the category, the worksheet window will be 
blank. 
 

Two 
Independently 

 scrolling regions 
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Right-click inside the window and select Add.  A new row will open ready for data to be 
entered.   
 
The required fields are:   
 Category No. 
 Item Number 
 Description (Non-std) – if non-standard item 
 Spec Book # Non-std – if non-standard item 
 Estimate Quantity 
 Proj. Item Seq. No. 
 

Category Number:  Enter the 4-digit category number for the item.  All items for all 
categories will be entered on the worksheet; therefore, each item must be identified 
to the proper category.  You may either enter the number or select the category 
from the drop-down arrow at the bottom of the column.  

 
Project Item Sequence Number:  This field may be left blank until all items are entered 

during your work session.  The numbers may then be assigned all at once by using 
the Assign Line Numbers process under the Edit menu.  See 8.2.2 Assigning 
Item Line Numbers. 

 
Proposal Line Number:  This field is filled in by Trns·port after generating line numbers 

in the proposal. 
 
Item Number:  Enter the 5-digit number for the item.  The number may be entered 

manually or may be chosen from the drop-down arrow at the bottom of the 
column.  Once the Item Code Table has been accessed, you can use the filter and 
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the advanced filter to search in the table for the desired item.  (See 2.8 Working 
with Filters (Searching) for help in searching for the items.)   

 
 Standard Items: On the following page is an example of an advanced filter search 

for UNDERDRAIN in the Drainage Items area (items 00500 – 09999). 
 
 

 
 

After filling in the three conditions, click on the APPLY button.  (When asked if you 
wish to save the filter, you may choose not to unless this is a search you perform 
frequently.)  The results of the search will be presented.   

 

 
 

DOE JJ 
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 Non-standard items:  Before using a non-standard item, be certain that there is not 
a standard item that is applicable.  Once you determine that there is not an 
applicable standard item, you will need to select one of the items in the table that is 
prefixed with NS.  These items are interspersed throughout the table in places 
where deemed appropriate.  Additionally, there are very general NS items at the 
end of many of the groupings; select from these very general NS items only as a 
last resort.   

 
 EXAMPLE:  You need to enter an item “Crosshole Sonic Logging” in the area of 

Bridge Substructure (Items 64000 – 66999).  You first search for it to see if you 
can find it as a standard item.  If you cannot find it, the next attempt would be to 
search for an appropriate NS item that applies.  See the search created for this: 

 
 

 
  
 
 After looking through the results of the search and still not finding an NS item that 

would apply to Crosshole Sonic Logging, you will notice that at the end of the 
search is a very general grouping of NS items: 

 

DOE JJ 
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 From this area, you may select the item with the appropriate Item Unit (CY, LF, 
etc.) and enter the specific wording for the item at the Description (Non-std) field. 

 
 Note:  The same NS item number may be used more than once in an estimate as 

long as the description you give at the Description (Non-Std) field is unique. 
 
Description:  This field is automatically filled in when the item number is entered. 
 
Lump Sum Units: Units:  These fields are automatically filled in when the item number 

is entered. 
 
Estimated Quantity:   Enter the quantity of the item.  Please Note: Enter the quantity 

of the item to the nearest 10th of the quantity on the plan, for example 2.5. 
Quantities entered in transport need to match what’s shown on the summary 
that the estimate is built from. 

 
Estimate Unit Price:  Leave this field blank for standard items.  When you have finished 

your estimate, the prices will be generated when you run the Generated Bid-Based 
Prices process.  The designer has the option to overwrite the generated price. 

 Fill in this field for non-standard items. 
 
Extended Amount:  When the quantity and estimated price are filled in, the extension of 

those two numbers is shown in this field.   
 
NS Description and Spec Book # Required:  This box will automatically check when 

you enter a Non-standard item number as a reminder that you are required to fill in 
Description Non-Std and Spec Book # Non-Std fields.  Those two fields will 
become required. 

 
Description (Non-Std):  This field is to be used only for non-standard items, and is a 

required field if a non-standard item number was entered.  Enter the wording 
needed to complete the non-standard item description.  This supplemental 
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description will be linked to the end of the item description chosen from the Item 
Lookup Table.  (For example, if your non-standard pay item is Parapet Modified, 
at the Item Number field, choose “NS Parapet” from the lookup table, and at this 
field, enter Modified. 

 
 IMPORTANT:  There will be occasions when you will be entering NS items for 

multiple projects that will be advertised on the same contract.  Consideration must 
be given to the non-standard descriptions as to whether or not you wish the items 
to be combined. 

 
o If you do not wish items to combine, be sure to give unique descriptions in 

this field. 
 

o If you wish items to combine, the descriptions given in this field must be 
exactly the same.  In addition, any other information you enter on the item 
screen must be exactly the same (spec book#, source of price, etc.). 

 
 Note:  The “NS” will print on the estimate, but will not print on the proposal. 
 
Spec Book # Non-Std:  This is a required field if a non-standard item number was 

entered.  Enter the Specification Number here, if known.  Up to three Specification 
Numbers, or 11 characters, may be entered.  You may also enter “ATTD” to 
indicate Special Provisions are attached or “PLAN” to indicate pertinent 
information is on the plans. 

 
Non-Bid Item:  Defaults to N.  For State Forces, Railroads and Utility Items (such as 

Verizon relocation, VA Power Relocation), change to Y.  These items will also 
require a separate category numbered between 2000 and 2999. 

 
Source of Price:  Defaults to GBBA.  For Non-Standard and Standard items priced by 

the user, enter E. 
 
Estimated Price Lock:  Defaults to N.  For Non-Standard items and Standard items 

priced by the user, enter Y to ensure that Trns·port will not price the item. 
 
Revised Price:  This field is reserved for Scheduling & Contract Division.  Changes from 

the estimated price can be tracked by utilizing this field. 
 
Combine w/Like Items:  Defaults to Y to combine like items on the proposal; change to 

N if you do not want to combine items on the proposal. 
 

When you have finished entering an item and are ready to enter another, right-click in the 
window and select Add.  A new row will be opened at the bottom.  Continue until you have 
entered all items.     
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8.2.1   Entering Mobilization and Construction Surveying 
 
Two items shall be entered on every L&D and S&B estimate: 
 

 00100 – Mobilization 

 00101 – Construction Surveying 
 
The items may be entered, with a quantity of 1, at the time the rest of the items are entered.  As 
these two items are to be priced by the designer, be sure to enter an E at Source of Price and a Y 
at Estimated Price Lock field.  Failure to change the Estimated Price Lock field will allow a 
price to be generated by Trns·port  - a price which is only an average of bid history prices, not 
the price based on the formula for which VDOT figures Mobilization and Construction 
Surveying.   
 
After the estimate has been renumbered and bid-based prices have been generated, the costs for 
these two items may be calculated and entered.  (Bridge users may enter cost for Construction 
Surveying at this time as it is generally $1500 per span.)  
 
Refer to 9.6 Construction Surveying, Mobilization, Construction Engineering for detailed 
instructions and formulas for these items. 
 

8.2.2   Assigning Item Line Numbers 
 
You will not be able to permanently save the Worksheet until line numbers have been assigned 
to all the items in a project.  Line numbers can be automatically generated by Trns·port.  While 
in the Worksheet tab, select Assign Line Numbers from the Edit menu and choose Project 
Items from the submenu.  Trns·port assigns line numbers using ten-digit increments.   
 
Note:  This is not to be confused with Renumbering Project Estimate Items.  The Assign Line 
Numbers process merely gives a number to each item; the items may still be out of sequence 
until the Renumbering Project Estimate Items process is run.  See 9.1 Renumbering the Items 
for instructions. 
 
After the line numbers have been assigned, click on the SAVE icon          to save your work to the 
database.   

 
o If you have completed all required field criteria satisfactorily, your items will be added.   

 

When the following screen displays, click on the YES button:  
 
 



 
VDOT Trns·port PES User’s Manual December 1, 2011 8-10 

                          
 

 
It is not recommended that you click the SAVE AS button as the system may become 
unstable resulting in loss of data or locked projects. 

 
o If a required field was not filled-in or incorrect data entered at a field which is supported 

with a reference table, a warning window will display with information.  For example, if 
you left a required field blank or entered invalid data, you will see an Project Tabbed 
Folder - Errors window giving information as to what field was left blank or contains an 
invalid value: 

 

 
 

8.3 Changing an Item 
 
Click on the Project List icon         to display the existing list of projects.    
 
On the project for which you wish to make changes to items, right-click and select Tabbed 
Folder Change.   Trns·port displays the tabbed folder.  Click on the Worksheet tab. 
 
Make changes to any existing item.   Click on the SAVE icon        to save your work to the 
database.  
 
You may need to re-calculate your Mobilization and Construction Surveying costs due to 
changes in your totals.  Refer to 9.6.1. Construction Surveying and 9.6.2  Mobilization. 

 
Do not click 
the SAVE AS 
button. 
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8.4 Deleting an Item 
 
Click on the Project List icon          to display the existing list of projects.    
 
On the project for which you wish to delete an item, right-click and select Tabbed Folder 
Change.   Trns·port displays the tabbed folder.  Click on the Worksheet tab. 
 
Right-click on the item you wish to delete and select Delete.  At the Delete Rows window which 
displays, click on the YES button.  Click on the SAVE icon         to save your work to the database. 
 
You may need to re-calculate your Mobilization and Construction Surveying costs due to 
changes in your totals.  Refer to 9.6.1. Construction Surveying and 9.6.2 Mobilization. 
 
 

8.5 Combining Projects 
 
You can have a co-worker assist you in entering your items.  The co-worker could enter half the 
items for the project in a “dummy” project and then you could combine the items from that 
project into your project.  Both projects must have the same Item Code Table and Unit System. 
 
When you are ready to import the co-worker’s items into your project, start at the Project Listing. 
Click on the Project List icon          to display the existing list of projects.      
Right-click on your project and select Tabbed Folder Change.  Click on the Worksheet tab. 
  
From the File menu, select Import.  Choose Combine Projects from the submenu.  Trns·port  
displays a list of all projects.  Select the “dummy” project to which your co-worker has been 
assigning items.  Trns·port loads all the item information to your worksheet. 
 
Before you can save the new items to the project, you must assign line numbers.  Refer to 8.2.2 
Assigning Item Line Numbers.  Click on the SAVE icon          to save your work to the database. 
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